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Using the FISAP process, you report expenses for Federal Campus-Based programs—the Federal Supplemental Education Opportunity Grant (FSEOG), Federal Work-Study, and Federal Perkins Loan programs. The Department of Education uses the distribution of expenditures to evaluate whether institutions are appropriating their federal allocation of Campus-Based funds to applicants with the most need. The reported spending levels affect subsequent year allocations. The programs enable you to transfer certain percentages of funds back to last year or forward to the next year to best use unexpended funds.
For your school to transmit, receive, and report FISAP data, you must submit your FISAP expenditures to the Department of Education through their FISAP website at http://www.cbfisap.sfa.ed.gov/. Your personal identification number (PIN) allows you access to information in various department systems. If you do not have a PIN, go to www.pin.ed.gov to apply. You must also have a TG number. The system uses the TG number to identify your school and your access rights to the eCampus-Based system. If you do not have a TG number, go to www.fsawebenroll.ed.gov.
Use the provided structured query report (SQR) to print and to enter the calculated values into the Department of Education FISAP for Windows or FISAP on the web. For audit purposes, the Department of Education requires that you keep data logs and backups of your final FISAP reports and any records necessary to support their data (for example, the source data for the income grid) for three years from the end of the award year for which you submitted the FISAP.
The following FISAP report information is generated:
Part II, Section E. Assessment and Expenditures: Total Federal Pell Expenditures, Academic Competitiveness Grant (ACG) and National SMART Grant expenditures, and Total Expended for State Grants and Scholarships Made to Undergraduates.
Part II, Section F. Information on Eligible Aid Applicants for Award Year.
Part IV, Section C. FSEOG Program: Total Funds to FSEOG Recipients and Non-Federal Share of Funds to FSEOG Recipients.
Part IV, Section D. Federal Funds Spent for FSEOG Program: Federal Share of Funds to FSEOG Recipients.
Part VI, Section A. Distribution of Program Recipients and Expenditures by Type of Student.
This section discusses:
Students selected for the report.
Assessments and expenditures.
Information on eligible aid applicants.
Distribution of program recipients and expenditures by type of student.
[bookmark: _Toc83041754]Students Selected
The FISAP report includes only students who:
· Have an FA Term (financial aid term) build source of T-Term or M-Manual. You can view the source on the FA Term Build Statistics page.
· Have an official Institutional Student Information Record (ISIR) on file. You can view the status of a student's ISIR using the EFC Status (expected family contribution status) field on the Federal EFC Summary page.
· Are eligible citizens based on the Social Security Administration (SSA) Citizenship Indicator database match, DHS/INS database match, and secondary DHS/INS database match. You can view the student's citizenship status in the SSA Citizenship Indicator field on the Database Matches page. Additional logic allows either the DHS/INS Match Override or SSA Citizenship Indicator Override on the Database Matches page to determine eligible citizenship status. To do this, select either the SSA Citizenship Override check box or the DHS/INS Match Override check box or both on the Eligible Aid Applicants for Award Year 20nn-20nn page.
· Have awards with financial aid item types of FSEOG, Federal Perkins Loan, Federal Work-Study, or Federal Pell Grant at the time of disbursement. Even if the institution changes the financial aid item type of the award after disbursing the award, the FISAP report still counts the student and the award amount in the proper category.
The FISAP report uses the following rules when categorizing the selected students:
· The most recent effective-dated sequenced ISIR row for students who meet the above report selection criteria.
· The student's National Student Loan Data System (NSLDS) loan year value determines whether the report counts the student as an undergraduate or graduate for the FISAP report.
· If a student is less than full-time based on enrollment status in the final term of the award year, the system counts the student as less than full-time for the entire year for FISAP purposes.
· Total FISAP income is derived directly from the student's ISIR.
· The Central Processing System (CPS) assigns students who meet certain tax filing and income criteria for an automatic EFC of zero. These students have an automatic zero EFC flag set to yes on their ISIR. If set to yes, this flag is on the EFC/DB Matches page in the ISIR Corrections component.
· To qualify as an Auto Zero EFC candidate on the report, the CPS must process the student's ISIR as official and must flag it with a Y in the Auto Zero EFC field. If you make changes to the student's ISIR record, and INAS determines that the student qualifies as an Auto Zero EFC candidate, schools must have the ISIR reprocessed by the CPS. The FISAP report identifies Auto Zero EFC candidates as all students with a Y value for AUTO_ZERO_EFC on the ISIR_COMPUTED table and an O value in EFC_STATUS on the ISIR_CONTROL table.
· The third page of the FISAP report identifies graduate students who received an FSEOG as an undergraduate student in a previous term in the same award year. This page is for your information, because these students are included and reported in the appropriate sections of Application Part VI of the Program Summary Grid, based on the Department of Education's instructions. These instructions stipulate that the funds received by these FSEOG recipients should be categorized in the appropriate undergraduate category (dependent or independent by income). If the student received only FSEOG, the student is also included in the undergraduate category for the unduplicated count. If the recipient also received Federal Perkins or Federal Work-Study funds, only the student's undergraduate FSEOG funds must be reported in the appropriate undergraduate category.
The student is then reported in the unduplicated recipients column only once by using the student's career in the final term of the award year (in this case, as a graduate student). For Federal Perkins and Federal Work-Study students, a student's career for the final term of the award year determines a student's career for FISAP purposes. To verify manually that these students are categorized correctly, use the information on the third page of the SQR report. The system does not generate a third page if no graduate students with an FSEOG exist.

[bookmark: _Toc83041755]Assessments and Expenditures
Part II, Section E of the FISAP report lists total expenditures in dollar amounts. The report process gathers award disbursement information based on financial aid item type setup to calculate the total Pell, ACG and SMART grant expenditures for the aid year. Financial aid item type is defined with a Source value of Federal and a Federal ID value of Pell, ACG, or SMART on the Financial Aid Item Type 1 page. These totals include all students who received a Pell, ACG and/or SMART grant award, regardless of NSLDS loan year.
The system calculates the total for state grant and scholarship expenditures to undergraduates for the award year from award disbursement information based on financial aid item type setup. Financial aid item type setup is defined with a Source value of State and a Federal ID value of Grant or Scholarship on the Financial Aid Item Type 1 page. For each term, the student must also be an undergraduate according to their NSLDS loan year (NSLDS loan years 0 through 5). The calculation does not gather award disbursement information for terms when the student is a graduate.


[bookmark: _Toc83041756]Information on Eligible Aid Applicants
Part II, Section F of the report lists the number of eligible aid applicants in an institution by income level. At various taxable and untaxed income levels, it tracks the following information:
	FISAP Report Column
	Eligible Aid Applicants

	A
	Dependent undergraduates without degrees.

	B
	Dependent undergraduates with degrees.

	C
	Independent undergraduates without degrees.

	D
	Independent undergraduates with degrees.

	E
	Graduate and professional students.



[bookmark: _Toc83041757]Distribution of Program Recipients and Expenditures by Type of Student
Part VI, Section A lists the number of students receiving Federal Perkins, FSEOG, and Federal Work-Study awards at various undergraduate dependent, undergraduate independent, and graduate and professional income levels. You can view both the number of recipients and amount of funds for each aid type. This section also lists totals for each aid type and for "automatic" zero EFC students, and provides a summary of funds and recipients at each income level.
The counts in this section of the FISAP report are unduplicated counts because the system counts each student once, whether or not a student receives multiple types of awards.
	FISAP Report Column
	Distribution of Program Recipients

	A
	Federal Perkins Loan Recipients

	B
	Federal Perkins Loan Funds

	C
	FSEOG Recipients

	D
	FSEOG Funds

	E
	FWS Recipients

	F
	FWS Funds

	G
	Unduplicated Count of Students[footnoteRef:1] [1:  PeopleBooks, Oracle; Docs, PeopleSoft CS 9.2, Understanding the FISAP Report ] 
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	Process
	Process Name
	Process Description
	Review Log Required?

	Query Extract
	
	Pulling Work Study List
	

	File Upload/Download
	
	Upload extract file
	

	Process External Award File
	SFA_EA_STAGE
	Staging extract file
	

	Review Staging Tables
	
	Reviewing staged extract file 
	

	Load External Award File
	FAPPKEAL
	Loading extract file
	

	Manage Awards by Status
	
	Reviewing error list
	

	Mange Student External Awards
	
	Correcting students with errors
	


[bookmark: _Toc83041760]Running FISAP
	Process
	Process Name
	Process Description
	Review Log Required?

	FISAP Report 20xx-20xx
	FAPFSPxx
	Generating FISAP Report
	Y – View/Log Trace

	File Upload/Download
	
	Downloading .CSV files for review
	

	Unduplicated Head Count query
	PSQUERY
	Outcomes used for reporting
	

	Tuition query 
	PSQUERY
	Outcomes used for reporting
	




[bookmark: _Toc83041761]Processing for FISAP
Disclaimer:
In order for the FISAP processes below to work accurately, work study awards need to be reconciled. The External Award Process outlined below is used to post students’ actual work study earnings as “Disbursed” on the student award page. 
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This query will extract the accepted term amounts from the award page for work study FA Item Types that have “Work Study” in the Federal ID field on the FA Item Type 1 page in the FA Item Type setup.
	Navigation
	Description

	Navigation:  Navigator > Nav Bar > Reporting Tools > Query Viewer
	Work study extract query 



· Enter the following query name:  CTC_FA_FISAP_WORKSTUDY_EXTRACT
· Select Search
· From the Search Results select HTML
[image: ]
Enter the following:
· Institution
· Aid Year
[image: ]
The downloaded file will appear above your task bar (for Chrome).  It may look different for different browsers.  Download the results to an Excel Spreadsheet.
[image: ]
When the spreadsheet opens, select Enable Editing and Delete the top 2 rows (Title Rows)
Save the file to your computer as CSV (i.e. comma delimited) file type.

[image: ]

[image: ]
 
Name the file so it can be identified for the upload.

Note: Do not open the csv file once it has been saved to your desktop. Opening the csv may cause the file to error during processing.  
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The file created will need to be uploaded for processing to the PeopleSoft server to be used in the following steps
	Navigation
	Description

	Navigation:  Nav Bar > Navigator > PeopleTools > CTC Custom > Extensions > Upload/Download Files
	Uploading recently created work study extract file. 



Enter the following:
· Academic Institution
· Select Search
· Choose appropriate Business Process Name – External Awards 2021
[image: ]
Select Upload and browse for the desired file
When the desired file is located select Upload
Select OK when successfully uploaded
[image: ]
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	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Financial Aid > Awards > External Awards > Process External Award File
	Loads extracted file into External Award staging tables for processing



Enter a New or Existing Run Control ID 
Select Search

Enter the following information:
· Institution
· Aid Year
· Load Action = Offer/Accept (The file built will ensure that the disbursed amounts are updated)
· File Mapping ID = CTC_FA_EXTERNAL_AWARDS_DISB_ID
· File Path= /CSTRANSFER/WAxxx/ExternalAwards20yy/zzz
· Where xxx represents the college code (ex: WA171), yy represents the aid year associated with the folder in the file path where you uploaded the file to and zzz represents the file name uploaded in previous step
· Select Run
[image: ]

From the Process Scheduler Request page select OK
[image: ]

Ensure the process runs to “Success” and “Posted”
[image: ]



[bookmark: _Toc83041765]Review Staging Tables
	Navigation
	Description

	Navigation:  Navigator > Nav Bar > Financial Aid > Awards > External Awards > View Data File Staging Results
	Reviewing staged data for processing to include student count review, processing status, and student data



Enter the following:
· Academic Institution
· Aid Year
· Select Search
Choose the Transaction Number 
The Transaction Number will be the most current transaction date

[image: ]

When the page opens, review the following:
It is important that you verify that the Institution and Aid Year associated with the Transaction Number is correct.  It‘s possible that multiple colleges could be running the process simultaneously.  If you select the incorrect Transaction Number, you may inadvertently process records for another institution.    

Transaction number – Note this number it will be used for subsequent processing
Student Count – This count should match the number of students listed on the loaded Excel Spreadsheet
The list of students below the file data will show that they are “Unprocessed”

[image: ]
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	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Financial Aid > Awards > External Awards > Load External Awards
	Moving staged data to award tables



Enter a New or Existing Run Control
From the Load External Awards page enter the following information:
· Institution
· Aid Year	
· Status = Unprocessed
· Data Source = External File
· File Mapping ID = CTC_FA_EXTERNAL_AWARDS_DISB_ID
· Transaction Date = The date the file was processed
· Transaction Number (Pulled from earlier processing)The CTCEXCLDEA equation is used to ensure the current Processing Status for students is not altered.

Update Aid Processing Status
· Exclude = CTCEXCLDEA
Load Processing Rules will default Error
Select Run 
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From the Process Scheduler Request page select OK
[image: ]

Ensure the process runs to “Success” and “Posted”



Note the instance number; it will be used in the search criteria of the next step 
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	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Financial Aid > Awards > External Awards > External Award Load Summary
	Reviewing the summary of the loaded file. Taking note of the number of students who have been processed, skipped or have loaded to error. 



Enter the following:
· Academic Institution 
· Aid Year
· Instance number from previous step
· Select Search
[image: ]



Review the External Award Load Summary to see the processing status of the students in the file
[image: ]

If Errors occur or a student is Skipped, the number of students in the situation will appear next to Skipped or In Error on the External Award Load Summary page. Details on how to load those students are in the processing instructions below. 
If there are no students Skipped or In Error, you will not have any error files to review in the next step; instead, you may continue your processing by navigating to section: Running the FISAP Report.  
[bookmark: _heading=h.2jxsxqh]
Review Error Files
	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Financial Aid > Awards > External Awards > Manage Awards by Status
	Reviewing list of students who have loaded with an Error status.  Used in subsequent processing. 



The following section details how to correct students who have encountered errors. If you do not have any errors, skip to Running the FISAP Report section. 
Enter the following information:
· Academic Institution
· Aid Year
· Processing Status = Error
· Transaction Number  
· Select Search
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The list of students with Errors is produced
[image: ]
This list will be used in the next section of processing. 
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	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Financial Aid > Awards > External Awards > Manage Student External Awards
	Steps for processing errors encountered during the load process. 



If you did not have any errors, go to the next step: Running the FISAP Report.
Enter the following information:
· Student ID
· Academic Institution
· Aid Year 
· Select Search
[image: ]


When the page opens select the Award tab
[image: ]
From the Award tab select the Detail link
[image: ]


Alter the Award Amounts and Disbursement numbers
In the example below, the student’s first disbursement has zero dollars so the entry needs to be removed. 
In instances where the first disbursement has zero dollars, the zero dollar disbursement would need to be removed, and the second and third disbursements need to be renumbered to ‘1’ and ‘2’.
In instances where the second or third disbursement has zero dollars, the zero dollar disbursement(s) would need to be removed, and the first and subsequent disbursements would need to be renumbered ‘1’ and ‘2’.
Ensure the Disbursed Amounts are totaled correctly in the Award Amount and Disbursed Amount fields
[image: ]
[image: ]
Select OK

From the Manage Student External Awards page 
Update the Status value from “Error” to “Unprocessed” and select Load
[image: ]
Review the Assign Awards to a Student page to view the update to the disbursement field for each term(s).
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	Navigation
	Description

	Navigation:  Main Menu > Financial Aid > Fund Management > Generate FISAP Reports > FISAP Report 20xx-20xx
	Running the FISAP report



Note:  The year range on the navigation menu represents the aid year the FISAP Report is requesting funds for. Ensure that once you are on the “Report on Eligible Aid Applicants for Award Year…” page, that the Aid Year you are reporting FROM is reflected on the top of the page.  For example, when requesting for funding for the 2022-2023 Aid Year, the FISAP page should list “Report on Eligible Aid Applicants for Award Year 2020-2021”.
· Enter a New or Existing Run Control ID
· Choose the Institution from the drop down menu
· Choose the Aid Year you are reporting on from the drop down menu.
· See note below for using overrides and Print Student List fields
· If using Print Student List functionality choose a file path that allows files to be downloaded
· Select Run

[image: ]
See explanation of Overrides below

[image: ]
“Are eligible citizens based on the Social Security Administration (SSA) Citizenship Indicator database match, DHS/INS database match, and secondary DHS/INS database match. You can view the student's citizenship status in the SSA Citizenship Indicator field on the Database Matches page. Additional logic allows either the DHS/INS Match Override or SSA Citizenship Indicator Override on the Database Matches page to determine eligible citizenship status. To do this, select either the SSA Citizenship Override check box or the DHS/INS Match Override check box or both on the Eligible Aid Applicants for Award Year 20nn-20nn page.”
By selecting the SSA Citizenship and DHS/INS Match override check boxes you ensure the students you overrode the database match on during the aid year will be selected.  
[image: ]

Print Student List- Select this check box to get an itemized list of students reported in the Eligible Applicant and Program Summary grids.  See outcomes below.





From the Process Scheduler select OK
[image: ]

Ensure that the process runs to “Success” and “Posted
[image: ]
Select the Details link





From the Process Detail page select View Log/Trace
[image: ]
From the View Log/Trac select the fapfspxx_xxxxxxx.PDF link
[image: ]
The FISAP report will open
Review for discrepancies and update source information as needed
This report can be run multiple times until desired outcome is achieved
[image: ]
Report outcomes to Department of Education
Select the fapfspxx_xxxxxxxx.out link
[image: ]
This will display a list of Empl IDs, and various ISIR and FA Term information used in FISAP selection.
Messages will be displayed for some students.  It can include the following:
· No Active STDNT_FA_TERM found for EMPLID=xxxxxxxxx
[image: ]
Navigate to FA Term page to confirm no FA Term has been built for the student at your institution

· No NSLDS_LOAN_YEAR on STDNT_FA_TERM for EMPLID=xxxxxxxxx
[image: ]
These students can be reviewed for accuracy

Review FA Term to ensure information correct 
[image: ]


Review Award page to confirm no Campus-Based Aid awards have been assigned for students with both messages
[image: ]





At the end of the student list will be the .CSV files that contain the itemized list of students reported in the Eligible Applicant and Program Summary grids. *Please Note*
The list of .CSV files will be available when using the Print Student List functionality while running FISAP

· ELIGAPPL- Eligible Applicants
· DISTFWSP- FWSP Recipients
· DISTPERK- Perkins Recipients 
· DISTSEOG- SEOG Recipients
· DISTUNDP- Unduplicated Count
[image: ]
Copy the .CSV file name and use the upload/download page to open the information.
This copy/paste can be done for each of the categories indicated above.  
Use the same File Path used while running the FISAP process.
[image: ] 

[bookmark: _Toc83041770]Reporting for Section D and E of FISAP

	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query
	The following queries have been developed to fulfill the need of reporting Unduplicated and Tuition and Fees for FISAP.  



QCS_SR_FISAP_UNDUPL_HEADCOUNT 
This query presents an unduplicated headcount of students enrolled during any given Aid Year by Institution.
Due to size of the query the recommendation is to run it using Schedule Query
· Enter a New or Existing Run Control ID
· Enter the query name and select search
· When the Scheduled Query Search Page opens select the Query link
· Enter Edit Prompts
· Select OK
[image: ]




Select Run
[image: ]
Ensure the process runs to Success and Posted

From the Schedule Query page select Report Manager
[image: ]
Select Undupl Headcount by Aid Year
[image: ]
When the report page opens select the QCS_SR_FISAP_UNDUPL_HEADCOUNT-xxxxxxx.CSV (Where xxxxxxx is Process Instance number)
A download request will be opened depending on browser – Select OK



Allow the .csv file to open
This step will display the count
[image: ]



	Navigation
	Description

	Navigation:  Nav Bar > Navigator > Reporting Tools > Query > Schedule Query
	The following queries have been developed to fulfill the need of reporting Unduplicated and Tuition and Fees for FISAP.  



QCS_SF_FISAP_TUITAMT
This query is designed to present tuition and fees for the students identified in the unduplicated head count query.  The following is included in the tuition amount calculations:
· Tuition Fees
· Mandatory Fees
· Self-Support (Credit) 
· Course Fees
· Waivers

Due to size of the query the recommendation is to run it using Schedule Query
· Enter a New or Existing Run Control ID
· Enter the query name and select search
· When the Scheduled Query Search Page opens select the Query link
· Enter Edit Prompts
· Select OK
[image: ]

Select Run
[image: ]
Ensure the process runs to Success and Posted


From the Schedule Query page select the Report Manager
[image: ]


Select FISAP Tuition Amount
[image: ]

When the report page opens select the QCS_SF_FISAP_TUITAMT-xxxxxxx.CSV (Where xxxxxxx is Process Instance number)
A download request will be opened depending on browser – Select OK
Allow the .csv file to open
This step will display the amount
[image: ]

End of Process
[bookmark: _Toc83041771]Troubleshooting

Users have various methods available to assist with reconciliation troubleshooting.  
By running various queries and reports such as the Fund Roster a user can pinpoint where discrepancies have occurred.
Please see Fund Management Business Processing Guide for running queries and Fund Roster.


The example below shows a discrepancy that was found by running the Fund Roster and filtering the columns to discover students that did not have funds authorized and disbursed.  It can also show were cancellations have occurred but the funds and not been un-authorized and un-disbursed.

The discrepancy was found by taking your SEOG Total Query xlsx file and summing the Offered, Accepted, Authorized, and Disbursed columns.  
[image: ]
Filter by those zero amounts that are in the Authorized/Disbursed columns.  It was discovered that two students’ incorrect aid were displayed.  Their awards would need to be adjusted on the award page and the authorization and disbursement process would need to occur to clear these errors.
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